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Enhancing Your
Work with
Pictures and
Drawings
In Excel, you find lots of tools, shapes, and formatting options that

help you utilize and control the attributes of drawing objects. As
with charts, you can place these objects on a worksheet’s draw
layer to add pizzazz to an otherwise boring report.
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If you place an object on your worksheet, the object goes on the
worksheet’s draw layer. The draw layer is an invisible surface that’s
completely independent of the cells on the worksheet. The draw
layer can hold graphic images, drawings, embedded charts, and
so on.

Objects that you place on the draw layer you can move, resize,
copy, and delete — with no effect on any other elements in the
worksheet.

Remember: The Drawing toolbar has two menu items — Draw and
AutoShapes. They are menu items because they operate exactly
like any menu item on the menu bar (i.e. they contain menus and
submenus). The arrows associated with these menu items are
unfortunately misleading because it appears as if you can click the
arrow separately from the item name — you can’t. Whether you
click the menu item name or the menu item arrow, you’re selecting
only one thing, and that’s the menu item.

Adding a Drawing Object to a Worksheet
Although you can access the drawing tools from the Insert➪ Picture
menu command, your best course is to use the Drawing toolbar —
which contains quick access to all the drawing features. To display
the Drawing toolbar, choose View➪ Toolbars➪ Drawing from the
menu bar.

You can also click the Drawing button on the Standard toolbar
to display the Drawing toolbar.

The easiest way to add a drawing object on your worksheet is via
the AutoShapes menu item on the Drawing toolbar. If you click the
AutoShapes menu item, Excel displays a menu of drawing objects
in the following eight categories:
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� Lines (6 styles)

� Connectors (9 styles)

� Basic shapes (32 styles)

� Block Arrows (28 styles)

� Flowchart (28 styles)

� Stars and Banners (16 styles)

� Callouts (20 styles)

� More AutoShapes (Displays a list of clip art in the Insert Clip
Art task pane)

Follow these steps to add a drawing object on your worksheet:

1. Click the AutoShapes menu item and select a category.

2. Click a particular shape from the palette that appears.

The mouse pointer changes to a thin cross and the palette of
shapes disappear.

3. Position the mouse pointer at the spot in the worksheet where
you want the shape to appear and then drag to create the
shape.

4. Release the mouse button.

The drawn object appears selected on the worksheet, and its
generic name appears in the Name Box. You can rename the
object by typing a new name in the Name Box.

Remember: You cannot drag the object from the palette to the
worksheet. You must first click the object and then drag the mouse
pointer on the worksheet to create the object.

You can control how objects appear on the worksheet by selecting
the appropriate option in the View tab of the Options dialog box.
(Choose Tools➪ Options from the menu bar to open the dialog box
and click the View tab.) In the Objects area of the View tab, the
Show All radio button is selected by default. You can hide all
objects by selecting the Hide All radio button or display objects as
placeholders by selecting the Show Placeholders radio button.
(This option may speed things up if you have complex objects that
take a long time to redraw.) The following are a few techniques that
you can use in adding an object to the worksheet:

� To draw an object that has the same height and width dimen-
sions, press Shift as you draw the objects.

� To constrain a line or arrow object to angles that are divisible
by 15 degrees, press Shift as you draw the object.
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� To make an object line up precisely to the worksheet row and
column gridlines, press the Alt key as you draw the object.

Remember: By default, drawing objects print along with the work-
sheet. If you don’t want the objects to print, you have the following
two options:

� Access the Sheet tab of the Page Setup dialog box and select
the Draft Quality option. See the section “Printing in Draft
Quality,” in Part VIII, for details.

� Right-click the object, choose Format AutoShape from the
shortcut menu that appears, and deselect the Print Object
check box on the Properties tab of the dialog box that appears.

Controlling How Objects Interact with Cells
Objects on the draw layer have properties that relate to how they
move and change size if you move and size underlying cells. To
change an object’s properties, follow these steps:

1. Double-click the object to display its particular Format dialog
box.

2. Click the Properties tab in the Format dialog box.

3. Select the appropriate radio button, as we describe in the fol-
lowing list:

• Move and size with cells: If you select this option, the
object appears to attach itself to the cells beneath it. If you
insert rows above the object, for example, the object moves
down. If you increase the column width, the object gets
wider.
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• Move but don’t size with cells: If you select this option, the
object moves if you insert rows or columns, but it never
changes its size if you change row heights or column
widths.

• Don’t move or size with cells: If you select this option, the
object is completely independent of the underlying cells.

4. Click OK.

Excel also enables you to attach an object to a cell. To do so, follow
these steps:

1. Choose Tools➪ Options from the menu bar.

2. Click the Edit tab of the Options dialog box that appears.

3. Select the Cut, Copy, and Sort Objects with Cells check box.

4. Click OK.

Graphic objects on the draw layer now attach to the under-
lying cells.

Copying a Drawing Object
The easiest way to make an exact copy of a drawing object is to
select the object (by clicking it), press Ctrl, and then drag. After
you release the mouse button, Excel creates a new copy of the
object.

Deleting All Drawing Objects
To delete all objects on a worksheet, follow these steps:

1. Choose Edit➪ Go To from the menu bar (or press F5).

2. Click the Special button in the Go To dialog box.

3. Choose the Objects radio button in the Go To Special dialog
box that appears and then click OK.

All objects are selected; press Delete to delete them all.

Importing Graphic Files
A wide assortment of graphic files (sometimes known as clip art) is
available, and you can use these images in your work without vio-
lating any copyright restrictions. Excel can import most graphics
files that you can place on a worksheet’s draw layer.
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To add a graphic file to a worksheet, you can use either of the fol-
lowing methods:

� Choose Insert➪ Picture➪ From File from the menu bar to locate
a particular file that’s on a disk.

� Choose Insert➪ Picture➪ Clip Art from the menu bar to display
the Insert Clip Art task pane (if it isn’t already on-screen). The
Insert Clip Art task pane enables you to search for a particular
graphic file on a local drive, network server, the Web, and so on.
The task pane also enables you to select an image from the
Office Clip Organizer. The Clip Organizer is an Office Program
that contains drawings, photographs, and other media files that
you can insert on the worksheet’s drawing layer.

After you place an image on a worksheet, you can move and resize
it. You can also use the tools on the Picture toolbar to manipulate
the image. The Picture toolbar appears after you select a picture.

Remember: Depending on the type of image, resizing may or may
not produce good results.

Using graphics in a worksheet can dramatically increase the size of
your workbook, resulting in more memory usage and longer load
and save times.

See also “Applying a Background Graphic,” in Part VII.

Modifying a Drawing Object
Excel enables you to modify a drawing object that you place on the
worksheet in several ways. You can, for example, format an object to
add fill color or fill effects, add a shadow, or make a two-dimensional
object three-dimensional. The following sections explain how to per-
form these tasks.

Formatting drawing objects
After you draw an object, you can format it at any time by following
these steps:

1. Double-click the object to display its Format dialog box.

2. Select a tab for the formatting option you want to apply.

The Colors and Lines tab, for example, allows you to select fill
color, fill effects, transparency and so on for the object. Select
your options from the available drop-down list boxes.

3. Click OK.
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The Drawing toolbar includes buttons, such as Fill Color, Line Style,
Shadow Style and so on, that enable you to quickly change the for-
matting of drawing objects. See the following sections immediately in
this part for a discussion of the Shadow Style and 3-D Style buttons.

The various formatting options enable you to modify the character-
istics of a given AutoShape object. If you want to change the
AutoShape that Excel associates with a given object, choose
Draw➪ Change AutoShape from the Drawing toolbar and select a
new shape from the palette that appears.

Adding a shadow to a drawing object
To add a shadow to a drawing object, follow these steps:

1. Click the object to select it.

2. Click the Shadow Style button on the Drawing toolbar.

A palette appears that shows 20 shadow styles.

3. Click one of the shadow styles to match the style and direction
of the shadow you want to apply to the object.

Click the appropriate button on the Shadow Settings toolbar to
make adjustments to the style that you select. Using the buttons on
the Shadow Settings toolbar, you can nudge the shadow in any one
of four directions and/or select a different color for the shadow. To
display the Shadow Settings toolbar, select the Shadow Settings
option at the bottom of the Shadow Style palette.

See also “Making a drawing object three dimensional,” immediately
following in this part.

Making a drawing object three dimensional
To add a three-dimensional (3-D) appearance to a drawing object,
follow these steps:

1. Click the object to select it.

2. Click the 3-D Style button on the Drawing toolbar.

A palette appears that shows 20 3-D styles.

Modifying a Drawing Object 7



3. Click one of the 3-D styles to match the style and direction of
the 3-D “extrusion” you want to apply to the object.

Click the appropriate button on the 3-D Settings toolbar to make
adjustments to the style that you select. Using the buttons on the
3-D Settings toolbar, you can adjust the depth, direction, color and
so on of the 3-D object. To display the 3-D Settings toolbar, select
the 3-D Settings option at the bottom of the 3-D Style palette.

See also “Adding a shadow to a drawing object,” immediately pre-
ceding in this part.

Moving and Resizing Drawing Objects
To move a drawn object, follow these steps:

1. Click the object to select it.

2. Drag the object to its desired location.

If you press Alt while moving an object, the object’s upper-left
corner perfectly aligns to the row and column gridlines.

To move a drawing object one pixel at a time, choose Draw➪ Nudge
from the Drawing toolbar and select an option from the Nudge
menu (Up, Down, Left or Right).

To change the size or proportions of a drawn object, follow these
steps:

1. Click the object to select it.

2. Click one of its eight selection handles that appear.

The handles are the small circles around the border of the
object.

3. Drag the handle until the object reaches the size that you
want.

To maintain an object’s original proportions as you resize the
object, press Shift while dragging any of its borders.
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Rotating a Drawing Object
You can rotate drawing objects to any angle. To rotate a drawing
object, follow these steps

1. Click the object to select it.

2. Choose Draw➪ Rotate or Flip➪ Free Rotate from the Drawing
toolbar.

The object displays four green rotate handles on its corners.

3. Click and drag one of the handles to rotate the object to the
angle that you want.

To remove the rotate handles on the object, Choose Draw➪ Rotate
or Flip➪ Free Rotate from the Drawing toolbar.

Working with Multiple Drawing Objects
Sometimes you’re working with a group of related drawing objects
on your worksheet. Excel provides many useful tools to enable you
to work with a group of drawing objects, as the following sections
describe.

Selecting a group of drawing objects
To select more than one drawing object, you can press Shift or Ctrl
as you click the objects that you want to select.

Another way to select a group of objects is to click the Select
Objects button on the Drawing toolbar. After you do so, the
mouse pointer turns into an arrow. You can then drag the mouse
pointer around the group of objects to select them. To restore
the mouse pointer to normal, press Esc (which also deselects
the objects) or click the Select Objects button again. (This latter
action doesn’t deselect the objects.)

Grouping and ungrouping objects
Excel enables you to combine two or more drawn objects into a
single object. This procedure is known as grouping. You can manip-
ulate a group as a single object (moving it, resizing it, and so on).

To group two or more objects, follow these steps:

1. Select all objects that you want in the group by pressing Shift
or Ctrl as you click each object.

2. Right-click an object to display a shortcut menu.
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3. Choose Grouping➪ Group from the shortcut menu.

Excel places handles around the group.

If you need to modify one of the objects in the group, you can
ungroup the objects by following these steps:

1. Right-click the grouped object to display a shortcut menu.

2. Choose Grouping➪ Ungroup from the shortcut menu.

Excel breaks the object into its original components.

Changing the stack order of drawn objects
As you add drawing objects to the draw layer of a worksheet, you
find that objects stack on top of each other in the order in which
you add them. New objects stack on top of older objects.

If you find that an object is obscuring part of another, you can
change the order of objects in the stack by following these steps:

1. Right-click the object to display its shortcut menu.

2. Choose Order from the shortcut menu and then choose the
appropriate command on the Order submenu, as follows:

• Choose Order➪ Bring to Front to move the object to the top
of the stack.

• Choose Order➪ Bring Forward to bring the object one step
toward the top in the stack order.

• Choose Order➪ Send to Back to move the object to the
bottom of the stack.

• Choose Order➪ Send Backward to send the object one step
to the bottom in the stack order.

Aligning and spacing drawing objects
If you have several drawing objects on a worksheet, you may want
to align them in some way (left, right center and so on) or evenly
space them on the worksheet. Follow these steps to align or space
your objects:

1. Select all objects that you want to align or space by pressing
Shift or Ctrl as you click each object.

2. Choose Draw➪ Align or Distribute from the Drawing toolbar.

Excel displays the Align or Distribute menu.
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3. To align the objects, select an Align option from the Align or
Distribute menu.

To space the objects, select a Distribute option from the Align
or Distribute menu.

See also “Selecting a group of drawing objects,” earlier in this part.
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